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Copyright © 2006 Parametric Technology Corporation. All Rights Reserved.

User and training documentation from Parametric Technology Corporation and its subsidiary companies (PTC) is subject to the copyright 
laws of the United States and other countries and is provided under a license agreement that restricts copying, disclosure, and use of such 
documentation. PTC hereby grants to the licensed user the right to make copies in printed form of this documentation if provided on software 
media, but only for internal/personal use and in accordance with the license agreement under which the applicable software is licensed. Any 
copy made shall include the PTC copyright notice and any other proprietary notice provided by PTC. This documentation may not be 
disclosed, transferred, modified, or reduced to any form, including electronic media, or transmitted or made publicly available by any means 
without the prior written consent of PTC and no authorization is granted to make copies for such purposes.

Information described herein is furnished for general information only, is subject to change without notice, and should not be construed as a 
warranty or commitment by PTC. PTC assumes no responsibility or liability for any errors or inaccuracies that may appear in this document.

The software described in this document is provided under written license agreement, contains valuable trade secrets and proprietary 
information, and is protected by the copyright laws of the United States and other countries. It may not be copied or distributed in any form 
or medium, disclosed to third parties, or used in any manner not provided for in the software licenses agreement except with written prior 
approval from PTC. UNAUTHORIZED USE OF SOFTWARE OR ITS DOCUMENTATION CAN RESULT IN CIVIL DAMAGES AND 
CRIMINAL PROSECUTION.

Registered Trademarks of Parametric Technology Corporation or a Subsidiary
Advanced Surface Design, Arbortext, Behavioral Modeling, CADDS, Computervision, CounterPart, Create • Collaborate • Control, EPD, 
EPD.Connect, Expert Machinist, Flexible Engineering, GRANITE, HARNESSDESIGN, Info*Engine, InPart, MECHANICA, Optegra, 
Parametric Technology, Parametric Technology Corporation, PartSpeak, PHOTORENDER, Pro/DESKTOP, Pro/E, Pro/ENGINEER, 
Pro/HELP, Pro/INTRALINK, Pro/MECHANICA, Pro/TOOLKIT, Product First, Product Development Means Business,
Product Makes the Company, PTC, the PTC logo, PT/Products, Shaping Innovation, Simple • Powerful • Connected,
The Way to Product First, and Windchill.

Trademarks of Parametric Technology Corporation or a Subsidiary
3DPAINT, Arbortext Editor, Arbortext Contributor, Arbortext Companion for MS Word®, Arbortext Advanced Print Publisher – Desktop, 
Arbortext Advanced Print Publisher – Enterprise, Arbortext Publishing Engine, Arbortext Dynamic Link Manager, Arbortext Styler, 
Arbortext Architect, Arbortext Digital Media Publisher, Arbortext Adapter to Documentum®, Arbortext Adapter to Oracle®,
Associative Topology Bus, AutobuildZ, CDRS, CV, CVact, CVaec, CVdesign, CV DORS, CVMAC, CVNC, CVToolmaker,
Create • Collaborate • Control • Communicate, EDAcompare, EDAconduit, DataDoctor, DesignSuite, DIMENSION III,
Distributed Services Manager, DIVISION, e/ENGINEER, eNC Explorer, Expert Framework, Expert MoldBase, Expert Toolmaker, 
FlexPDM, FlexPLM, Harmony, InterComm, InterComm Expert, InterComm EDAcompare, InterComm EDAconduit, ISSM, KDiP, 
Knowledge Discipline in Practice, Knowledge System Driver, ModelCHECK, MoldShop, NC Builder, POLYCAPP, Pro/ANIMATE, 
Pro/ASSEMBLY, Pro/CABLING, Pro/CASTING, Pro/CDT, Pro/CMM, Pro/COLLABORATE, Pro/COMPOSITE, Pro/CONCEPT, 
Pro/CONVERT, Pro/DATA for PDGS, Pro/DESIGNER, Pro/DETAIL, Pro/DIAGRAM, Pro/DIEFACE, Pro/DRAW, Pro/ECAD, 
Pro/ENGINE, Pro/FEATURE, Pro/FEM POST, Pro/FICIENCY, Pro/FLY THROUGH, Pro/HARNESS, Pro/INTERFACE, 
Pro/LANGUAGE, Pro/LEGACY, Pro/LIBRARYACCESS, Pro/MESH, Pro/Model.View, Pro/MOLDESIGN, Pro/NC ADVANCED,
Pro/NC CHECK, Pro/NC MILL, Pro/NC POST, Pro/NC SHEETMETAL, Pro/NC TURN, Pro/NC WEDM, Pro/NC Wire EDM, 
Pro/NETWORK ANIMATOR, Pro/NOTEBOOK, Pro/PDM, Pro/PHOTORENDER, Pro/PIPING, Pro/PLASTIC ADVISOR, Pro/PLOT, 
Pro/POWER DESIGN, Pro/PROCESS, Pro/REPORT, Pro/REVIEW, Pro/SCAN TOOLS, Pro/SHEETMETAL, Pro/SURFACE, 
Pro/VERIFY, Pro/Web.Link, Pro/Web.Publish, Pro/WELDING, ProductView, PTC Precision, Routed Systems Designer, Shrinkwrap,
The Product Development Company, Validation Manager, Warp, Wildfire, Windchill DynamicDesignLink, Windchill PartsLink,
Windchill PDMLink, Windchill ProjectLink, and Windchill SupplyLink.

Patents of Parametric Technology Corporation or a Subsidiary
Registration numbers and issue dates follow. Additionally, equivalent patents may be issued or pending outside of the United States. Contact 
PTC for further information. GB2366639B   13-October-2004. GB2363208   25-August-2004. (EP/DE/GB)0812447   26-May-2004. 
GB2365567   10-March-2004. (GB)2388003B   21-January-2004. 6,665,569 B1   16-December-2003. GB2353115   10-December-2003. 
6,625,607 B1   23-September-2003. 6,580,428 B1   17-June-2003. GB2354684B   02-July-2003. GB2384125   15-October-2003. 
GB2354096   12-November-2003. GB2354924   24-September-2003. 6,608,623 B1   19-August-2003. GB2353376   05-November-2003. 
GB2354686   15-October-2003. 6,545,671 B1   08-April-2003. GB2354685B   18-June-2003. GB2354683B   04-June-2003. 6,608,623 B1   
19-August-2003. 6,473,673 B1   29-October-2002. GB2354683B   04-June-2003. 6,447,223 B1   10-Sept-2002. 6,308,144   
23-October-2001. 5,680,523   21-October-1997. 5,838,331   17-November-1998. 4,956,771   11-September-1990. 5,058,000   
15-October-1991. 5,140,321   18-August-1992. 5,423,023   05-June-1990. 4,310,615   21-December-1998. 4,310,614   30-April-1996. 
4,310,614   22-April-1999. 5,297,053   22-March-1994. 5,513,316   30-April-1996. 5,689,711   18-November-1997. 5,506,950   
09-April-1996. 5,428,772   27-June-1995. 5,850,535   15-December-1998. 5,557,176   09-November-1996. 5,561,747   01-October-1996. 
(EP)0240557   02-October-1986.



Third-Party Trademarks
Adobe, Acrobat, Distiller, and the Acrobat logo are trademarks of Adobe Systems Incorporated. IBM, AIX, and Websphere are registered 
trademarks of IBM Corporation. Allegro, Cadence, and Concept are registered trademarks of Cadence Design Systems, Inc. Apple, Mac, 
Mac OS, Panther and Tiger are trademarks or registered trademarks of Apple Computer, Inc. AutoCAD and Autodesk Inventor are registered 
trademarks of Autodesk, Inc. Baan is a registered trademark of Baan Company. CADAM and CATIA are registered trademarks of Dassault 
Systemes. DataDirect Connect is a registered trademark of DataDirect Technologies. CYA, iArchive, HOTbackup, and Virtual StandBy are 
trademarks or registered trademarks of CYA Technologies, Inc. DOORS is a registered trademark of Telelogic AB. FLEXnet, InstallShield, 
and InstallAnywhere are trademarks or registered trademarks of Macrovision Corporation. Geomagic is a registered trademark of Raindrop 
Geomagic, Inc. EVERSYNC, GROOVE, GROOVEFEST, GROOVE.NET, GROOVE NETWORKS, iGROOVE, PEERWARE, and the 
interlocking circles logo are trademarks of Groove Networks, Inc. Helix is a trademark of Microcadam, Inc. HOOPS is a trademark of Tech 
Soft America, Inc. HP, Hewlett-Packard, and HP-UX are registered trademarks of Hewlett-Packard Company. Advanced ClusterProven, 
ClusterProven, the ClusterProven design, Rational Rose, and Rational ClearCase are trademarks or registered trademarks of International 
Business Machines Corporation in the United States and other countries and are used under license. IBM Corporation does not warrant and is 
not responsible for the operation of this software product. I-DEAS, Metaphase, Parasolid, SHERPA, Solid Edge, TeamCenter, UG-NX, and 
Unigraphics are trademarks or registered trademarks of UGS Corp. Intel is a registered trademark of Intel Corporation. IRIX is a registered 
trademark of Silicon Graphics, Inc. I-Run and ISOGEN are registered trademarks of Alias Ltd. LINUX is a registered trademark of Linus 
Torvalds. MainWin and Mainsoft are trademarks of Mainsoft Corporation. MatrixOne is a trademark of MatrixOne, Inc. Mentor Graphics 
and Board Station are registered trademarks and 3D Design, AMPLE, and Design Manager are trademarks of Mentor Graphics Corporation. 
MEDUSA and STHENO are trademarks of CAD Schroer GmbH. Microsoft, ActiveX, JScript, Windows, Windows NT, Windows 2000, 
Windows 2000 Server, Windows XP, Windows Server 2003, the Windows logo, Visual Basic, the Visual Basic logo and Active Accessibility 
are trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries. Moldflow is a registered 
trademark of Moldflow Corporation. Netscape and the Netscape N and Ship's Wheel logos are registered trademarks of Netscape 
Communications Corporation in the U.S. and other countries. Oracle and interMedia are registered trademarks of Oracle Corporation. 
OrbixWeb is a registered trademark of IONA Technologies PLC. PDGS is a registered trademark of Ford Motor Company. RAND is a 
trademark of RAND Worldwide. RetrievalWare is a registered trademark of Convera Corporation. RosettaNet is a trademark and Partner 
Interface Process and PIP are registered trademarks of RosettaNet, a nonprofit organization. SAP and R/3 are registered trademarks of SAP 
AG Germany. SolidWorks is a registered trademark of SolidWorks Corporation. All SPARC trademarks are used under license and are 
trademarks or registered trademarks of SPARC International, Inc. in the United States and in other countries. Products bearing SPARC 
trademarks are based upon an architecture developed by Sun Microsystems, Inc. Sun, Sun Microsystems, the Sun logo, Solaris, UltraSPARC, 
Java and all Java based marks, and “The Network is the Computer” are trademarks or registered trademarks of Sun Microsystems, Inc. in the 
United States and in other countries. 3Dconnexion is a registered trademark of Logitech International S.A. TIBCO is a registered trademark 
and TIBCO ActiveEnterprise, TIBCO Designer, TIBCO Enterprise Message Service, TIBCO Rendezvous, TIBCO TurboXML,
and TIBCO BusinessWorks are trademarks or registered trademarks of TIBCO Software Inc. in the United States and other countries. WebEx 
is a trademark of WebEx Communications, Inc. API Toolkit is a trademark of InterCAP Graphics Systems, Inc. BEA and WebLogic are 
registered trademarks of BEA Systems, Inc. BEA WebLogic Server and BEA WebLogic Platform are trademarks of BEA Systems, Inc. 
Compaq is a registered trademark of Compaq Computer Corporation. DEC is a registered trademark of Digital Equipment Corporation. 
Documentum and Documentum Administrator are trademarks of Documentum, Inc. Elan License Manager and Softlock are trademarks of 
Rainbow Technologies, Inc. JAWS is a registered trademark of Freedom Scientific BLV Group, LLC in the United States and other countries. 
FileNET is a registered trademark of FileNET Corporation. Panagon is a trademark of FileNET Corporation.
Galaxy Application Environment is a licensed trademark of Visix Software, Inc. Interleaf is a trademark of Interleaf, Inc. IslandDraw and 
IslandPaint are trademarks of Island Graphics Corporation. Netscape, Netscape Navigator, and Netscape Communicator are registered 
trademarks and service marks of Netscape Communications Corporation. OSF/Motif and Motif are trademarks of the Open Software 
Foundation, Inc. Palm Computing, Palm OS, Graffiti, HotSync, and Palm Modem are registered trademarks, and Palm III, Palm IIIe,
Palm IIIx, Palm V, Palm Vx, Palm VII, Palm, More connected, Simply Palm, the Palm Computing platform logo, all Palm logos, and 
HotSync logo are trademarks of Palm, Inc. or its subsidiaries. Proximity and Linguibase are registered trademarks of Proximity Technology, 
Inc. SPARC is a registered trademark and SPARCStation is a trademark of SPARC International, Inc. (products bearing the SPARC 
trademarks are based on an architecture developed by Sun Microsystems, Inc.). TeX is a trademark of the American Mathematical Society. 
UNIX is a registered trademark of The Open Group. X Window System is a trademark of X Consortium, Inc.

Third-Party Technology Information
Certain PTC software products contain licensed third-party technology:

Rational Rose and Rational ClearCase are copyrighted software of IBM Corp.

RetrievalWare is copyrighted software of Convera Corporation.

VisTools library is copyrighted software of Visual Kinematics, Inc. (VKI) containing confidential trade secret information belonging to VKI.

HOOPS graphics system is a proprietary software product of, and is copyrighted by, Tech Soft America, Inc.

I-Run and ISOGEN are copyrighted software of Alias Ltd. 

Xdriver is copyrighted software of 3Dconnexion, Inc, a Logitech International S.A. company. 

G POST is copyrighted software and a registered trademark of Intercim.



VERICUT is copyrighted software and a registered trademark of CGTech.

FLEXnet Publisher is copyrighted software of Macrovision Corporation

Pro/PLASTIC ADVISOR is powered by Moldflow technology.

Fatigue Advisor nCode libraries from nCode International.

TetMesh-GHS3D provided by Simulog Technologies, a business unit of Simulog S.A.

MainWin Dedicated Libraries are copyrighted software of Mainsoft Corporation.

DFORMD.DLL is copyrighted software from Compaq Computer Corporation and may not be distributed. 

LightWork Libraries are copyrighted by LightWork Design 1990–2001.

Visual Basic for Applications and Internet Explorer is copyrighted software of Microsoft Corporation. 

Parasolid is © UGS Corp.

TECHNOMATIX is copyrighted software and contains proprietary information of Technomatix Technologies Ltd. 

TIBCO ActiveEnterprise, TIBCO Designer, TIBCO Enterprise Message Service, TIBCO Rendezvous, TIBCO TurboXML,
and TIBCO BusinessWorks are provided by TIBCO Software Inc. 

DataDirect Connect is copyrighted software of DataDirect Technologies.

Technology "Powered by Groove" is provided by Groove Networks, Inc. 

Technology "Powered by WebEx" is provided by WebEx Communications, Inc.

Oracle 8i run-time, Oracle 9i run-time, and Oracle 10g run-time are Copyright 2002–2004 Oracle Corporation. Oracle programs provided 
herein are subject to a restricted use license and can only be used in conjunction with the PTC software they are provided with.

Adobe Acrobat Reader and Adobe Distiller are copyrighted software of Adobe Systems Inc. and are subject to the Adobe End-User License 
Agreement as provided by Adobe with those products.

Certain license management is based on Elan License Manager © 1989-1999 Rainbow Technologies, Inc. All rights reserved.

Portions compiled from Microsoft Developer Network Redistributable Sample Code, Copyright © 1998 by Microsoft Corporation.

The CD-ROM Composer and CD-ROM Consumer are based on Vivace CD-Web Composer Integrator © 1996-1997 KnowledgeSet 
Corporation. All rights reserved.

Larson CGM Engine 8.0, Copyright © 1992-2002 Larson Software Technology, Inc. All rights reserved.

Certain graphics-handling portions are based on the following technologies:

GIF: Copyright 1989, 1990 Kirk L. Johnson. The author disclaims all warranties with regard to this software, including all implied 
warranties of merchantability and fitness. In no event shall the author be liable for any special, indirect, or consequential damages or 
any damages whatsoever resulting from loss of use, data or profits, whether in an action of contract, negligence, or other tortious action, 
arising out of or in connection with the use or performance of this software. 

JPEG: This software is based in part on the work of the Independent JPEG Group. 

PNG: Copyright 2000, 2001 Glenn Randers-Pehrson.

TIFF: Copyright 1988-1997 Sam Leffler, Copyright © 1991-1997 Silicon Graphics, Inc. The software is provided AS IS and without 
warranty of any kind, express, implied, or otherwise, including without limitation, any warranty of merchantability or fitness for a 
particular purpose. In no event shall Sam Leffler or Silicon Graphics be liable for any special, incidental, indirect, or consequential 
damages of any kind, or any damages whatsoever resulting from loss of use, data or profits, whether or not advised of the possibility of 
damage, or on any theory of liability, arising out of or in connection with the use or performance of this software. 

XBM, Sun Raster, and Sun Icon: Copyright,1987, Massachusetts Institute of Technology. 



ZLIB: Copyright 1995-1998 Jean-loup Gailly and Mark Adler.

PDFlib software is copyright © 1997-2003 PDFlib GmbH. All rights reserved. 

PStill software is copyright © Dipl.- Ing. Frank Siegert, 1996-2004

Proximity Linguistic Technology provides spelling portions of certain software products: The Proximity/Bertelsmann Lexikon Verlag 
Database. Copyright © 1997 Bertelsmann Lexikon Verlag. Copyright © 1997, All Rights Reserved, Proximity Technology, Inc.; The 
Proximity/C.A. Strombertg AB Database. Copyright © 1989 C.A. Strombertg AB. Copyright © 1989, All Rights Reserved, Proximity 
Technology, Inc.; The Proximity/Editions Fernand Nathan Database. Copyright © 1984 Editions Fernand Nathan. Copyright © 1989, All 
Rights Reserved, Proximity Technology, Inc.; The Proximity/Espasa-Calpe Database. Copyright © 1990 Espasa-Calpe. Copyright © 1990, 
All Rights Reserved, Proximity Technology, Inc.; The Proximity/Dr. Lluis de Yzaguirre i Maura Database. Copyright © 1991 Dr. Lluis de 
Yzaguirre i Maura Copyright © 1991, All Rights Reserved, Proximity Technology, Inc.; The Proximity/Franklin Electronic Publishers, Inc. 
Database. Copyright © 1994 Franklin Electronic Publishers, Inc. Copyright © 1994, All Rights Reserved, Proximity Technology, Inc.; The 
Proximity/Hachette Database. Copyright © 1992 Hachette. Copyright © 1992, All Rights Reserved, Proximity Technology, Inc.; The 
Proximity/IDE a.s. Database. Copyright © 1989, 1990 IDE a.s. Copyright © 1989, 1990, All Rights Reserved, Proximity Technology, Inc.; 
The Proximity/Merriam-Webster, Inc. Database. Copyright © 1984, 1990 Merriam-Webster, Inc. Copyright © 1984, 1990, All Rights 
Reserved, Proximity Technology, Inc.; The Proximity/Merriam-Webster, Inc./Franklin Electronic Publishers, Inc. Database. Copyright © 
1990 Merriam-Webster Inc. Copyright © 1994 Franklin Electronic Publishers, Inc. Copyright © 1994, All Rights Reserved, Proximity 
Technology, Inc.; The Proximity/Munksgaard International Publishers Ltd. Database. Copyright © 1990 Munksgaard International 
Publishers Ltd. Copyright © 1990, All Rights Reserved, Proximity Technology, Inc.; The Proximity/S. Fischer Verlag Database. Copyright © 
1983 S. Fischer Verlag. Copyright © 1997, All Rights Reserved, Proximity Technology, Inc.; The Proximity/Van Dale Lexicografie by 
Database. Copyright © 1995, 1997 Van Dale Lexicografie by. Copyright © 1996, 1997, All Rights Reserved, Proximity Technology, Inc.; 
The Proximity/William Collins Sons & Co. Ltd. Database. Copyright © 1984, 1990 William Collins Sons & Co. Ltd. Copyright © 1988, 
1990, All Rights Reserved, Proximity Technology, Inc.; The Proximity/Zanichelli Database. Copyright © 1989 Zanichelli. Copyright © 
1989, All Rights Reserved, Proximity Technology, Inc. 

The Arbortext Import/Export feature includes components that are licensed and copyrighted by CambridgeDocs LLC (© 2002-2005 
CambridgeDocs LLC). This functionality:

Includes software developed by the Apache Software Foundation (http://www.apache.org/).

Redistributes JRE 1.4.2_08 from Sun Microsystems. The Redistributable is complete and unmodified, and only bundled as part of the 
product. CambridgeDocs is not distributing additional software intended to supersede any component(s) of the Redistributable, nor has 
CambridgeDocs removed or altered any proprietary legends or notices contained in or on the Redistributable. CambridgeDocs is only 
distributing the Redistributable pursuant to a license agreement that protects Sun’s interests consistent with the terms contained in the 
Agreement. CambridgeDocs agrees to defend and indemnify Sun and its licensors from and against any damages, costs, liabilities, 
settlement amounts and/or expenses (including attorney’s fees) incurred in connection with any claim, lawsuit, or action by any third 
party that arises or results from the use or distribution of any and all Programs and/or Software. This product includes code licensed 
from RSA Security, Inc. Some portions licensed from IBM are available at http://oss.software.ibm.com/icu4j/.

Redistributes the Saxon XSLT Processor from Michael Kay, more information, including source code is available at 
http://saxon.sourceforge.net/.

Uses cxImage, an open source image conversion library that follows the zlib license. cxImage further uses the following images 
libraries which also ship (statically linked) with cxLib: zLib, LibTIFF, LibPNG, LibJPEG, JBIG-Kit, JasPer, LibJ2K. See 
http://www.xdp.it/cximage.htm. 

Includes software developed by Andy Clark, namely Neko DTD. NekoDTD is © Copyright 2002, 2003, Andy Clark. All rights 
reserved. For more information, visit http://www.apache.org/~andyc/neko/doc/index.html.

Includes code which was developed and copyright by Steven John Metsker, and shipped with Building Parsers with Java, from Addison 
Wesley.

Uses controls from Infragistics NetAdvantage 2004, Volume 3, © Copyright 2004 Infragistics.

Word, FrameMaker, and Interleaf filters. Copyright © 2000 Blueberry Software. All rights reserved.

Portions of software documentation are used with the permission of the World Wide Web Consortium. Copyright © 1994–2004 World Wide 
Web Consortium, (Massachusetts Institute of Technology, European Research Consortium for Informatics and Mathematics, Keio 
University). All Rights Reserved. http://www.w3.org/Consortium/Legal/. Such portions are indicated at their points of use.

Copyright and ownership of certain software components is with YARD SOFTWARE SYSTEMS LIMITED, unauthorized use and copying 
of which is hereby prohibited. YARD SOFTWARE SYSTEMS LIMITED 1987. (Lic. #YSS:SC:9107001) 



**********

METIS, developed by George Karypis and Vipin Kumar at the University of Minnesota, can be researched at 
http://www.cs.umn.edu/~karypis/metis. METIS is © 1997 Regents of the University of Minnesota.

Certain software components licensed in connection with the Apache Software Foundation, all rights reserved, and use is subject to the terms 
and limitations at http://www.apache.org/. Apache software is provided by its Contributors AS IS, WITHOUT WARRANTIES OR 
CONDITIONS OF ANY KIND, and any expressed or implied warranties, including, but not limited to, the implied warranties of title 
non-infringement, merchantability and fitness for a particular purpose are disclaimed. In no event shall the Apache Software Foundation or 
its Contributors be liable for any direct, indirect, incidental, special, exemplary, or consequential damages (including, but not limited to, 
procurement of substitute goods or services; loss of use, data, or profits; or business interruption) however caused and on any theory of 
liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising in any way out of the use of this software, even 
if advised of the possibility of such damage. Apache software includes:

Apache Server, Tomcat, Xalan, Xerces, and Jakarta, Jarkarta POI, Jakarta Regulat Expression, Commons-FileUpload 

IBM XML Parser for Java Edition, the IBM SaxParser and the IBM Lotus XSL Edition

DITA-OT - Apache License Version

Pop-up calendar components Copyright © 1998 Netscape Communications Corporation. All Rights Reserved. 

UnZip (© 1990 2001 Info ZIP, All Rights Reserved) is provided AS IS and WITHOUT WARRANTY OF ANY KIND. For the complete Info 
ZIP license see http://www.info-zip.org/doc/LICENSE.

The Java™ Telnet Applet (StatusPeer.java, TelnetIO.java, TelnetWrapper.java, TimedOutException.java), Copyright © 1996, 97 Mattias L. 
Jugel, Marcus Meißner, is redistributed under the GNU General Public License. This license is from the original copyright holder and the 
Applet is provided WITHOUT WARRANTY OF ANY KIND. You may obtain a copy of the source code for the Applet at 
http://www.mud.de/se/jta (for a charge of no more than the cost of physically performing the source distribution), by sending e-mail to 
leo@mud.de or marcus@mud.de—you are allowed to choose either distribution method. Said source code is likewise provided under the 
GNU General Public License. 

GTK+   The GIMP Toolkit is licensed under the GNU Library General Public License (LGPL). You may obtain a copy of the source code at 
http://www.gtk.org, which is likewise provided under the GNU LGPL. 

zlib software Copyright © 1995-2002 Jean-loup Gailly and Mark Adler. 

#ZipLib GNU software is developed for the Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA, 
copyright ©1989, 1991. PTC hereby disclaims all copyright interest in the program #ZipLib written by Mike Krueger. #ZipLib licensed free 
of charge and there is no warranty for the program, to the extent permitted by applicable law. Except when otherwise stated in writing the 
copyright holders and/or other parties provide the program AS IS without warranty of any kind, either expressed or implied, including, but 
not limited to, the implied warranties of merchantability and fitness for a particular purpose. The entire risk as to the quality and performance 
of the program is with you. Should the program prove defective, you assume the cost of all necessary servicing, repair or correction. 
OmniORB is distributed under the terms and conditions of the GNU General Public License - The OmniORB Libraries are released under the 
GNU LGPL. 

The Java Getopt.jar file, copyright 1987 1997 Free Software Foundation, Inc. 

Java Port copyright 1998 by Aaron M. Renn (arenn@urbanophile.com) is redistributed under the GNU LGPL. You may obtain a copy of the 
source code at http://www.urbanophile.com/arenn/hacking/download.html. The source code is likewise provided under the GNU LGPL. 

CUP Parser Generator Copyright ©1996-1999 by Scott Hudson, Frank Flannery, C. Scott Ananian–used by permission. The authors and their 
employers disclaim all warranties with regard to this software, including all implied warranties of merchantability and fitness. In no event 
shall the authors or their employers be liable for any special, indirect or consequential damages, or any damages whatsoever resulting from 
loss of use, data or profits, whether in an action of contract, negligence or other tortious action arising out of or in connection with the use or 
performance of this software.

Software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org): Copyright © 1998 2003 The 
OpenSSL Project. All rights reserved. This product may include cryptographic software written by Eric Young (eay@cryptsoft.com). 

ImageMagick software is Copyright © 1999-2005 ImageMagick Studio LLC, a nonprofit organization dedicated to making 
software-imaging solutions freely available. ImageMagick is freely available without charge and provided pursuant to the following license 
agreement: http://www.imagemagick.org/script/license.php.



Mozilla Japanese localization components are subject to the Netscape Public License Version 1.1 (at http://www.mozilla.org/NPL). Software 
distributed under the Netscape Public License (NPL) is distributed on an AS IS basis, WITHOUT WARRANTY OF ANY KIND, either 
expressed or implied (see the NPL for the rights and limitations that are governing different languages). The Original Code is Mozilla 
Communicator client code, released March 31, 1998 and the Initial Developer of the Original Code is Netscape Communications 
Corporation. Portions created by Netscape are Copyright © 1998 Netscape Communications Corporation. All Rights Reserved. Contributors: 
Kazu Yamamoto (kazu@mozilla.gr.jp), Ryoichi Furukawa (furu@mozilla.gr.jp), Tsukasa Maruyama (mal@mozilla.gr.jp), Teiji Matsuba 
(matsuba@dream.com).

The following components are subject to the Mozilla Public License Version 1.1 at http://www.mozilla.org/MPL (the MPL). Software 
distributed under the MPL is distributed on an AS IS basis, WITHOUT WARRANTY OF ANY KIND, either expressed or implied and all 
warranty, support, indemnity or liability obligations under PTC’s software license agreements are provided by PTC. See the MPL for the 
specific language governing rights and limitations. Modifications to Mesilla source code are available under the MPL and are available upon 
request: Gecko and Mesilla components; text (www.lowagie.com/iText/). iCal4j is Copyright © 2005, Ben Fortuna, All rights reserved. 
Redistribution and use of iCal4j in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met: (i) Redistributions of source code must retain the above copyright notice, this list of conditions, and the following 
disclaimer; (ii) Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the following disclaimer 
in the documentation and/or other materials provided with the distribution; and (iii) Neither the name of Ben Fortuna nor the names of any 
other contributors may be used to endorse or promote products derived from this software without specific prior written permission. iCal4j 
SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS AS IS AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, 
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The Independent JPEG Group's JPEG software. This software is Copyright © 1991-1998, Thomas G. Lane. All Rights Reserved. This 
software is based in part on the work of the Independent JPEG Group.

libpng, Copyright © 2004 Glenn Randers-Pehrson, which is distributed according to the disclaimer and license (as well as the list of 
Contributing Authors) at http://www.libpng.org/pub/png/src/libpng-LICENSE.txt.

Curl software, Copyright ©1996 - 2005, Daniel Stenberg, <daniel@haxx.se>. All rights reserved. Permission to use, copy, modify, and 
distribute this software for any purpose with or without fee is hereby granted, provided that the above copyright notice and this permission 
notice appear in all copies. THE SOFTWARE IS PROVIDED AS IS, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE 
AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN 
THE SOFTWARE. Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote 
the sale, use, or other dealings.

The cad2eda program utilizes wxWidgets (formerly wxWindows) libraries for its cross-platform UI API, which is licensed under the 
wxWindows Library License at http://www.wxwindows.org/.

LAPACK libraries used are freely available at www.netlib.org (authors are Anderson, E. and Bai, Z. and Bischof, C. and Blackford, S. and 
Demmel, J. and Dongarra, J. and Du Croz, J. and Greenbaum, A. and Hammarling, S. and McKenney, A. and Sorensen, D.).

The following software, which is provided with and called by certain PTC software products, is licensed under the GNU General Public 
License: Ghost Script (www.cs.wisc.edu/~ghost/); The PJA (Pure Java AWT) Toolkit library (www.eteks.com/pja/en/).

JFreeChart is licensed under the GNU LGPL and can be found at www.jfree.org.

Java Advanced Imaging (JAI) is provided pursuant to the Sun Java Distribution License (JDL) at www.jai.dev.java.net/. The terms of the JDL 
shall supersede any other licensing terms for PTC software with respect to JAI components.

UNITED STATES GOVERNMENT RESTRICTED RIGHTS LEGEND
This document and the software described herein are Commercial Computer Documentation and Software, pursuant to FAR 12.212(a)-(b) 
(OCT’95) or DFARS 227.7202-1(a) and 227.7202-3(a) (JUN’95), and are provided to the US Government under a limited commercial 
license only. For procurements predating the above clauses, use, duplication, or disclosure by the Government is subject to the restrictions set 
forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software Clause at DFARS 252.227 7013 (OCT’88) or 
Commercial Computer Software-Restricted Rights at FAR 52.227 19(c)(1)-(2) (JUN’87), as applicable. 010106

Parametric Technology Corporation, 140 Kendrick Street, Needham, MA 02494 USA
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About This Guide

Documentation Conventions
The documentation uses the following conventions:

Code Examples 

Some code examples in this guide have been reformatted for presentation 
purposes and, therefore, may contain hidden editing characters (such as tabs and 
end-of-line characters) and extraneous spaces. If you cut and paste code from this 
manual, check for these characters and remove them before attempting to use the 
example in your application.

Convention Item Example

Code code examples

command line text

set projName=

Processing completed.

File name file name demo_file.eda

User Interface 
Element

Names of elements in the user interface such as 
buttons, menu paths, and dialog box titles.

Required elements and keywords or characters 
in syntax formats.

Click OK.

Select File>Save.

License File dialog box
1



Technical Support

Contact PTC Technical Support if you encounter any problems:

• http://www.ptc.com/support

• Phone:  1-800-477-6435

• CS_PTC@ptc.com

For faster service, please provide the following information:

• The exact software version (Choose Help>About)

• Your Customer Number *

• Your SCN (Service Contract Number) *

• A detailed description of the problem and any information you can provide on 
how to reproduce the problem.

* If you do not have this information, please call 1-877-275-4782. Explain to the 
technician that you need access to your company's Customer Number and Service 
Contract Number.

For complete details, refer to the Contacting Technical Support section of the 
PTC Customer Service Guide at: http://www.ptc.com/support/cs_guide

Documentation
The PTC Web site provides a search facility that allows you to locate Technical 
Support documentation of particular interest, including the latest update of this 
guide. To access this page, use the following link: 
http://www.ptc.com/appserver/cs/search/search.jsp

Comments

PTC welcomes your suggestions and comments on its documentation. You can 
submit your feedback for this guide to the following email address: 
ECAD_Docs@ptc.com
2
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All InterComm™ Products

This document includes the procedures for acquiring and configuring all of the 
InterComm products:

• InterComm Expert

• InterComm EDAcompare

• InterComm EDAconduit

Follow the procedures in this document for downloading, licensing, and installing 
everything you’ll need for all of the InterComm products. 
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Creating a Web Account

You must have a Premium Web Account for your company in order to access 
software and other services on the PTC.com website. 

You will need to have your PTC Customer Number AND one of the following:

• Service Contract Number (SCN) 

• Sales Order Number (SON) 

• Site Number 

If you do not know this information, call 1-877-275-4782 and select option 1 for 
License Management.

� To create a web account:

1. To create a web account, use the following link: 
http://www.ptc.com/appserver/common/account/basic.jsp 

2. On the New Account page complete the form and select Create Account. 

3. On the confirmation page, you will see an option to Upgrade Your Access. 
Choose that link. 

4. On the Upgrade Your ptc.com Account page complete the form and select 
Upgrade. 

5. You will then receive two emails at the email address you provided: 

– Subject line: Important Action Required – Please Activate Your 
ptc.com Account — This email contains a link to activate your account. 
If you do not activate the account, you will not be able to gain access to 
the areas you have requested. Click the link in the email and follow the 
instructions in the email and on the website. 

– Subject line: ptc.com Account Activation Confirmation – No Action 
Required — In this email, you will find a list of your new access areas. 

6. After you have activated your account using the link provided, you will be 
able to access all of your areas on the PTC.com website. 

http://www.ptc.com/appserver/common/account/basic.jsp
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Subscribing to Products

By subscribing to specific products, you will receive email automatically about 
new Knowledge Base information including:

• Technical Application Note (TAN) — Documents which describe specific 
technical issues with PTC software; these generally include work-around 
information and information on anticipated software corrections. 

• Technical Point of Interest (TPI) — Technical tips which are not necessarily 
associated with a particular release of a PTC software product. 

This procedure is optional but is HIGHLY recommended. 

� To subscribe to specific products:

1. To subscribe to specific products, use the following link: 
http://www.ptc.com/support

2. On the Support page, under Self Help select Subscriptions. 

3. Enter your PTC account username and password. (This is the username and 
password you used in the Creating a Web Account section on page 4.) Click 
OK. 

4. On the Knowledge Base Monitor page, you see a table listing any current 
subscriptions. Most likely this will be empty. Below that you see a table 
where you can add a new subscription. 

5. In the Select Product field, select a product. 

6. Leave both the Module and Release fields set to Any. 

7. Check the boxes under TAN and TPI. 

8. Click Add. The subscription is added to the upper Current Subscriptions 
table. 

9. Repeat steps 5 through 8 for each InterComm product (and for any other PTC 
products) you may be using. 

http://www.ptc.com/support/support.htm 
http://www.ptc.com/support


Requesting a License

IMPORTANT: If you currently have InterComm Expert 5.1 M060 and you need to 
upgrade your license to the current version, you will need to request a license 
from License management. To do this, follow the procedure in the Requesting an 
Upgrade License section on page 8.

Requesting a New License
You must have the associated license to run any PTC software. The following 
procedure explains how to request a node-locked or floating license. To request a 
Consignment license, please refer to Consignment Licensing on page 23. 

� To request a new license:

1. Go to the PTC Support website: http://www.ptc.com/support

2. Under Licensing Tools, select Configure New Software. 

3. Enter your PTC account username and password. (This is the username and 
password you used in the Creating a Web Account section on page 4.) 

4. When prompted, enter your Sales Order Number (SON) and click Continue. 
If you do not know your company’s SON, call 1-877-275-4782 and select 
option 1 for License Management. 

5. The next page lists the available products to install. Select the license 
feature(s) you want. (Refer to the License Features section on page 10 for 
instructions on which license features to select.) Click Continue. 

6. On the next page, select whether the license(s) will be installed on a Single 
Server or Triad server, whichever is applicable to your configuration. Click 
Continue. 

7. Select the number of licenses you want for each feature. If you want the same 
number of licenses for each feature, you can select the number in the Select x 
of each item box. This will automatically set the number for all of the licenses 
above. Click Continue. 

8. The next page is where you identify the system for which the license file will 
be configured. Use the following link 
http://www.ptc.com/olm/ist1071/ist1071.htm to determine your HOST ID.
6
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– To search for the machine, enter the CPU ID/Triad Leg or Host/Triad 
Name in the corresponding field and click Search. 

– To browse for the machine, leave all of the fields blank and click Browse. 
Find the machine in the list, click the option button next to that CPU ID, 
scroll to the bottom of the page, and click Continue. 

– To create a new server, enter the CPU ID in the Create a New 
Server/Triad field and click Create. 

9. On the next two pages leave the default values and click Continue. 

10. On the review transaction page, verify the information and click Submit 
Transaction. 

11. You are then presented with a confirmation that your request has been 
submitted. Please note the red call number for future reference. Your license 
file will be sent via email. 

NOTE: If you had any previously configured PTC license features, this process 
will create a new license file with the new features you requested as well as any 
previous configured license features.

IMPORTANT: Please review the sample license file at the end of this document 
to be sure that your license file has everything you need. 
7



Requesting an Upgrade License

IMPORTANT: If you currently have InterComm Expert 5.1 M060 and you need to 
upgrade your license to the current version, you will need to request a license 
from License management. With your request, you will need to provide your 
license server HOST ID. To determine this, use the following link: 
http://www.ptc.com/olm/ist1071/ist1071.htm.

� To request a license for an upgrade:

1. To request an upgrade license, use the following link: 
http://www.ptc.com/support

2. On the Support page, under Customer Care select Customer Care Call 
Logger. 

3. Enter your PTC account username and password (created in the Creating a 
Web Account section on page 4) and click OK. 

4. On the Customer Care Call Logger page, verify your information and click 
Next. 

5. When prompted, enter your Sales Order Number (SON) and click Continue. 
(If you do not know your company’s SON, call 1-877-275-4782 and select 
option 1 for License Management.)

6. On the next page, enter the following information: 

Callback Phone — enter your telephone number

Problem description — specify that you are requesting a upgrade license

Priority — select a priority level

Function — choose License Management Service 

Area — choose Upgrade 

Short Description — Specify that you are requesting a new InterComm 
Expert license and include the version. With your request, you will need to 
provide your license server HOST ID. To determine this, use the following 
link: http://www.ptc.com/olm/ist1071/ist1071.htm. 

Long Description — leave blank 
8
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7. Click Next. 

8. Review the information on the following page and then click Open a call. 

The next page confirms your call and provides a call number. Note this number. 
9



License Features

InterComm Expert License Features

As part of requesting a license for InterComm Expert, you will need to select not 
only a license, but license features as well. When selecting your InterComm 
Expert license, you must choose: 

• the InterComm Base License (shown in red) 

• the feature(s) for the InterComm configuration(s) that you purchased (shown 
in yellow) 

Note:  Depending upon the license(s) you purchased, your options may differ from 
those shown here.

* Node-locked licensing is supported only on Windows. For Solaris, you must use 
a Floating license.

InterComm EDAcompare License Features

When selecting your InterComm EDAcompare license, you must choose all of 
the following:

• InterComm EDAcompare Base License 

• InterComm EDAcompare - Full Version 

• InterComm Base for Expert 

• InterComm ICM_CFG_4 

Important Notes: 

– InterComm EDAcompare is available only for Windows and only with a 
Floating license.

License
Available License 
Feature

Available for

Floating Node-locked*

InterComm 
Base License

 InterComm Access 9 9

InterComm Access PLM 9 9

InterComm Expert 9 9

InterComm Expert PLM 9 9
10



– An InterComm Base for Expert is required for InterComm Expert, 
InterComm EDAcompare, and InterComm EDAconduit. Please be sure 
that the total number of InterComm Base for Expert licenses is equal to 
the number of licenses for InterComm Expert plus the number of 
InterComm EDAcompare licenses plus the number of InterComm 
EDAconduit licenses. 

InterComm EDAconduit License Features

When selecting your InterComm EDAconduit license, you must choose all of the 
following:

• InterComm EDAconduit Base License 

• InterComm EDAconduit For All 

• InterComm Base for Expert 

• InterComm ICM_CFG_1 

Important Notes: 

– An InterComm Base for Expert is required for InterComm Expert, 
InterComm EDAcompare, and InterComm EDAconduit. Please be sure 
that the total number of InterComm Base for Expert licenses is equal to 
the number of licenses for InterComm Expert plus the number of 
InterComm EDAcompare licenses plus the number of InterComm 
EDAconduit licenses. 

– For Windows, InterComm EDAconduit is available with a either a 
Floating or a Node-Locked license. 

– For Solaris, InterComm EDAconduit is available only with a Floating 
license. 

– In addition, if you are planning to run InterComm EDAconduit on Solaris, 
please contact your sales representative about purchasing the correct 
feature.
11



Downloading Your InterComm
Products

Downloading InterComm Expert
If you have the CD of InterComm Expert, you can skip this procedure and go 
straight to the next procedure. 

IMPORTANT: InterComm Expert is a product with several different 
configurations. The instructions provided here are applicable for all 
configurations of InterComm Expert, including: 

• Access 

• Access PLM 

• Expert 

• Expert PLM 

If you have purchased any of these configurations, please use the following 
procedure.

� To download InterComm Expert:

1. Go to the PTC website: http://www.ptc.com/cs/doc/intercomm_main.htm 

2. Enter your PTC account username and password. (This is the username and 
password you used in the Creating a Web Account section on page 4.) 

3. Scroll down to the Important Links header and select the link under the 
Downloading/Ordering CDs for InterComm Expert option. 

4. The next page confirms Your Information and your Customer Information 
(using either your Customer Number or Customer Name). Verify that the 
information is correct and click Continue. 

5. On the next page, select INTERCOMM in the Product Name drop-down 
box. 

6. The following page lists the versions of InterComm that are currently 
available. Most likely, you will want the most recent version, which will be 
12
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the first version listed. 

In the Download column there is an FTP and an HTTP download option for 
both the tar and zip format (indicated with a red circle below). 

Choose the format you want (tar or zip) and then click on the download 
method ([FTP] or [HTTP]) that corresponds to the format you want. 

7. Once the download is complete, click Exit Application. 

Downloading InterComm EDAcompare
If you have the CD of InterComm EDAcompare, you can skip this procedure and 
go to the next procedure. 

If, however, you don’t have InterComm EDAcompare yet, you can download the 
latest release from the PTC website. 

� To download InterComm EDAcompare:

1. Go to the PTC website: 
http://www.ptc.com/cs/doc/InterComm_EDAcompare.htm 

2. Enter your PTC account username and password. (This is the username and 
password you used in the Creating a Web Account section on page 4.) 

3. Scroll down to the Important Links header and select the link under the 
Downloading/Ordering CDs for InterComm EDAcompare option. 

4. The next page confirms Your Information and your Customer Information 
(using either your Customer Number or Customer Name). Verify that the 
information is correct and click Continue. 

5. On the next page, in the Product Name drop-down box select InterComm 
EDAcompare. 

6. The following page lists the versions of InterComm EDAcompare that are 
currently available. Most likely, you will want the most recent version, which 
will be the first version listed. 

Note:  This page also lists the versions of InterComm Expert are currently 
available. If you already have InterComm Expert, you do not need to 
download it. If you do not have InterComm Expert, please follow the 
13
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procedures in the other sections of this document as InterComm Expert 
requires additional licensing, installation, and configuration. 

7. In the Download column there is an FTP and an HTTP download option for 
both the tar and zip format. Choose the format you want (tar or zip) and then 
click on the download method ([FTP] or [HTTP]) that corresponds to the 
format you want.

8. Once the download is complete, click Exit Application. 

Downloading InterComm EDAconduit
If you have the CD of InterComm EDAconduit, you can skip this procedure and 
go to the next procedure. 

If, however, you don’t have InterComm EDAconduit yet, you can download the 
latest release from the PTC website. 

� To download InterComm EDAconduit:

1. Go to the PTC website: 
http://www.ptc.com/cs/doc/InterComm_EDAconduit.htm 

2. Enter your PTC account username and password. (This is the username and 
password you used in the Creating a Web Account section on page 4.) 

3. Scroll down to the Important Links header and select the link under the 
Downloading/Ordering CDs for InterComm EDAconduit option. 

4. The next page confirms Your Information and your Customer Information 
(using either your Customer Number or Customer Name). Verify that the 
information is correct and click Continue. 

5. On the next page, in the Product Name drop-down box select InterComm 
EDAconduit. 

6. The following page lists the versions of InterComm EDAconduit that are 
currently available. Most likely, you will want the most recent version, which 
will be the first version listed. 

Note:  This page also lists the versions of InterComm Expert are currently 
available. If you already have InterComm Expert, you do not need to 
14
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download it. If you do not have InterComm Expert, please follow the 
procedures in the other sections of this document as InterComm Expert 
requires additional licensing, installation, and configuration. 

7. In the Download column there is an FTP and an HTTP download option for 
both the tar and zip format. Choose the format you want (tar or zip) and then 
click on the download method ([FTP] or [HTTP]) that corresponds to the 
format you want.

8. Once the download is complete, click Exit Application. 
15
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Installing FLEXlm Server Software

FLEXlm server software only needs to be installed if your company has 
purchased an InterComm Expert floating license. If you need to install FLEXlm 
Server Software, it is included in the download or on the CD with InterComm 
Expert. Follow the instructions in the License_Server_Install.pdf 
included with the License Server Software. The software and the instructions are 
available at: http://www.ptc.com/cs/doc/InterComm_add-ons.htm

http://www.ptc.com/cs/doc/InterComm_add-ons.htm
http://www.ptc.com/cs/doc/InterComm_add-ons.htm


Installing Your PTC License File

Installing a Floating License

After you request a license you will get an email with a license file attached (in the 
format lm_xxxx.txt). 

� To install a floating license file:

1. Save the attachment as a .txt file on the license server. 

2. Run the PTC.Setup program.

– On a Windows system, the default path is: 
C:\Program Files\flexlm\bin\ptcsetup.bat

– On a Solaris system, the default path is: 
/opt/ptc/flexlm/bin/ptcsetup 

3. In the License File section, enter the path and name of the license file (from 
step 1 above). 

4. Click Configure. 

5. The strings __HOSTNAME__ and __PTCD_PATH in the SERVER and DAEMON 
lines are automatically replaced with the hostname of the license server and 
the path to the ptc_d executable located in the FLEXLM directory, 
respectively.

For example:

SERVER spock PTC_HOSTID = 11-22-33-44-55-66 7788
DAEMON ptc_d d:\ptc\flexlm\i486_nt\obj\ptc_d 

Your license is now installed. Continue to the next section for instructions on 
installing your software.

Installing a Node-locked License

After you request a license you will get an email with a license file attached (in the 
format lm_xxxx.txt). 

� To install a node-locked license file:
17



6. Save the attachment as a .txt file on the client system. 

7. Open license file (from step 1 above).

8. Type a # at the beginning of the SERVER and DAEMON lines in the license file.

For example:

#SERVER spock PTC_HOSTID = 11-22-33-44-55-66 7788
#DAEMON ptc_d d:\ptc\flexlm\i486_nt\obj\ptc_d 

9. Save and exit the file.

Your license is now installed. Continue to the next section for instructions on 
installing your software.
18
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Installing Your InterComm Products

Installing Intercomm Expert
For instructions on installing InterComm Expert, please refer to the InterComm 
Expert Instruction Manual for the version of InterComm Expert you are using.

Installing Intercomm EDAcompare
For instructions on installing InterComm EDAcompare, please refer to the 
InterComm EDAcompare Installation Manual for the version of InterComm 
EDAcompare you are using. 

Installing Intercomm EDAconduit
For instructions on installing InterComm EDAconduit, please refer to the 
InterComm EDAconduit Installation and Usage Manual for the version of 
InterComm EDAconduit you are using.

� To access the documents listed above:

1. Go to the following page: http://www.ptc.com/appserver/cs/doc/refdoc.jsp

2. Enter your PTC account username and password. (This is the username and 
password you used in the Creating a Web Account section on page 4.)

3. On the Reference Documents page, select the corresponding product from 
the Product field and select Installation and Configuration Guide in the 
Document Type field. 

4. In the Release field, select the corresponding release for the product you are 
using. 

5. Select Browse the reference documents.

http://www.ptc.com/appserver/cs/doc/refdoc.jsp


Configuring Your License

Configuring a Floating License

A floating license is the typical configuration for multiple users within a corporate 
network. You must have access to a valid license server. 

NOTES: 

• InterComm Expert running on Solaris only supports floating licenses. 

• InterComm EDAcompare only supports floating licenses. 

• If you have been running InterComm Expert for a demonstration period, you 
may have a demo license file on your system. You must reset your license 
before configuring the floating license. 

After you have installed and started the license server, each copy of InterComm 
Expert on client systems must be instructed to use the license server. 

� To set the license server location:

1. Start InterComm Expert. 

Whenever InterComm Expert cannot find a valid license (or when InterComm 
Expert is started the first time), the License Location dialog box displays. 

2. Select the Floating tab in the License Location dialog box. 

3. Enter the name of the server that holds the floating license. 
In some cases, you will need to use the full domain name of the server, such 
as: server.company.com 

4. If a port number was specified in the InterComm Expert server license file, 
then enter that port number in the Port field. The default is 7788. 

5. Click Done to complete the configuration. 

6. If you are working on InterComm Expert on Solaris, InterComm Expert will 
now close and display a message telling you to restart InterComm Expert. 
Restart InterComm Expert and your configuration is now complete. 

7. InterComm Expert can now locate the floating license on your server to open 
the InterComm Expert session. 
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Configuring a Node-locked License

A node-locked license is the typical configuration for stand-alone installations. 
You must have a valid license file stored in a local directory on your system, such 
as the InterComm Expert™ installation directory. 

IMPORTANT NOTES: 
– PTC licensing does not support a node-locked license environment 

variable of more than 100 characters. 

– InterComm Expert running on Solaris only supports floating licenses. 

– InterComm EDAcompare only supports floating licenses. 

– Be sure that the PTC license file has been installed based on the Installing 
Your PTC License File procedure on page 17, which includes a step to 
add a # in front of the server and daemon lines in the PTC license file. 

– The license configuration resulting from the following procedure will 
remain valid until you reset your license or your license expires. For more 
information, please see the License tab under the Help>About 
InterComm menu. 

� To configure a node-locked license:

1. Start InterComm Expert. 

Whenever InterComm Expert cannot find a valid license (or when InterComm 
Expert is started the first time), the License Location dialog box displays. 

2. Select the Node-Locked tab in the License Location dialog box. 

3. Click Browse to select your PTC license file, or enter the PTC license file 
name and path directly in the License file text field. 

4. Click Done to close the dialog box to open the InterComm session. 

Configuring a Demo License 

A demo license is a temporary node-locked license, typically expiring in 30 days. 

You are prompted to configure your license whenever you start InterComm 
Expert™ for the first time, or when you are starting InterComm Expert after using 
the Help>About InterComm>License tab to Reset your license to its original 
unconfigured state.

For more information, please see the License tab under the Help>About 
InterComm menu. Once you have obtained a valid license, you can configure 
your license just like a regular node-locked license.
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Consignment Licensing

If your organization or an organization that you work with has arranged for 
consignment licensing, you can obtain a temporary license that lets you:

• use InterComm Expert™ outside the context of your network 

• provide temporary access to InterComm Expert for partners outside your 
organization 

• borrow a license from another company that uses InterComm Expert 

A consignment license expires after the number of days you specified to have the 
license checked out. Then, the license becomes available to other consignment 
license users. When you start a new InterComm Expert session using a 
consignment license within a week of the license's expiration date, you will see a 
warning that tells you when the license expires. You can also use the Help>About 
InterComm Expert>License tab to check the status of your license.

Note:  The following procedure assumes that you have the current version of 
InterComm Expert installed and that your system has access to the Internet.

� To check out a consignment license:

1. Make sure your system has access to the Internet. 

2. Start InterComm Expert. 

Note:  Whenever InterComm Expert cannot find a valid license (or when 
InterComm Expert is started the first time), the License Location dialog box 
displays. 

3. Select the Consignment tab in the License Location dialog box. 

4. Select the Request a new Consignment License option. 

5. Click Next to display the License Manager wizard. 

6. Click Next to proceed to the next step in the License Manager. 

7. From the License Owner list, select the organization that is providing you the 
license. 
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8. Enter a valid Username and Password to gain access to the library of 
consignment licenses for the selected License Owner. 

– If you forget your Password, go to the following page: 
https://www.intercommcommunity.com/asp2/forget.asp. 

– If you forget both your Username and Password, send an email to 
support-edai@ptc.com with your company name and your email address 
and a contact phone number. 

9. Enter the Email address of the intended user of the consignment license. 

10. Click Next to proceed. 

11. Select the number of days you would like to have the consignment license 
checked out. 

12. Click Next to proceed. 

13. Click Finish to exit the wizard. 

� To install a consignment license:

If you are a permanent user, your license is installed automatically. 

If you are a temporary user, you will need to complete the following procedure:

You will receive an email that includes:

• your temporary license file 

• instructions for installing the license file 

• the expiration date and time 

1. Copy the license file attached to the email (Temporarylicense.txt) to 
your root directory (c:). 

2. Change the file extension to .dat (i.e., c:\Temporarylicense.dat) 

3. Start InterComm Expert. 

4. Select the Consignment Licensing tab. 

5. Select the Register... option. 

6. Click Done. 
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Sample License File 

 
#-------------------------------------------------------------------------- 
#Your call number is 1234567 
#-------------------------------------------------------------------------- 
 
#-------------------------------------------------------------------------- 
#License Pack for Request ID 12345678 
#This License pack was requested by: PTC Host ID AA-BB-CC-DD-EE-FF 
#-------------------------------------------------------------------------- 
 
 
#                 PTC License Pack 
#         IMPORTANT SOFTWARE LICENSING INFORMATION 
#              Retain this for your records. 

NOTE:  These features are not in the exact order 
that they will appear in your license file.  
They have been grouped here for easier 
identification. 

 
#Customer        :PTC 
#Site            :PTC 
#                :  
#                :140 KENDRICK STREET 
#                :  
#                :NEEDHAM, MA 02494 
#                :US 
 
#                :800-477-6435 
 
#Contact         :CHRIS SMITH 
#Email           :cs_ptc@ptc.com 
 
#Customer Number :111 
#Install Site No :9876543 
 
#**************************************** Summary Table ******************************************************* 
#                       PTC Host ID AA-BB-CC-DD-EE-FF 
#FeatureName            Qty        Product                            Release   Type    Expiration     Contract 
#************************************************************************************************************** 
#225                     2    InterComm EDAcompare - Full Version       2.1     Flt Opt    perm        1A111111 
#226                     2    InterComm EDAcompare - Full Version       2.1     Flt Opt    perm        1A111111 
#227                     2    InterComm EDAcompare - Full Version       2.1     Flt Opt    perm        1A111111 
#228                     2    InterComm EDAcompare - Full Version       2.1     Flt Opt    perm        1A111111 
#229                     2    InterComm EDAcompare - Full Version       2.1     Flt Opt    perm        1A111111 
#230                     2    InterComm EDAcompare - Full Version       2.1     Flt Opt    perm        1A111111 
#243                     2    ICM CFG 4                                 5.1     Flt Opt    perm        1A111111 
#EDACOMPARE              2    InterComm EDAcompare - Base               2.1     Flt Lic    perm        1A111111 
#240                     1    ICM CFG 1                                 5.1     Flt Opt    perm        1A111111 
#249                     1    EDA Conduit for All                       2.0     Flt Opt    perm        1A111111 
#EDAconduit              1    EDAconduit Base License                   2.0     Flt Lic    perm        1A111111 
#237                     3    InterComm Expert - 1 Country Floating     5.1     Flt Opt    perm        1A111111 
#InterComm               6    InterComm Base License                    5.1     Flt Lic    perm        1A111111 
 
#-------------------------------------------------------------------------- 
#START: License File for HOST ID AA-BB-CC-DD-EE-FF 
#-------------------------------------------------------------------------- 
 
SERVER __HOSTNAME__ PTC_HOSTID=AA-BB-CC-DD-EE-FF 7788 
DAEMON ptc_d "C:\Program Files\flexlm\i486_nt\obj\ptc_d.exe" "C:\Program Files\flexlm\licensing\ptc.opt" 
 
#################### FLOATING Option ##################### 
# Serviceable = InterComm EDAcompare - Full Version 
# Feature Name = 225 
# Feature Version = 2.1 
# Number of Copies = 2 
# Expiration Date = perm 
# Module = InterComm EDAcompare - Design 
INCREMENT 225 ptc_d 2.1 perm 2 20F05070F2732ABF9B73 \ 
 VENDOR_STRING="VSVER=2.0 LO=()" SUPERSEDE \ 
 ISSUER=PTC-WEB-INSTALL ISSUED=14-dec-2005 \ 

2 licenses of InterComm EDAcompare require 2 of each of these 
8 features plus the InterComm feature (explained below). 

1 license of InterComm EDAconduit requires 1 of each of these 3 
features plus the InterComm feature (explained below). 

3 licenses of InterComm Expert require 3 of this feature plus the 
InterComm feature (explained below). 

You must have an InterComm Base License for each license 
of InterComm EDAcompare, InterComm EDAconduit, and 
InterComm Expert. 

EDACOMPARE (InterComm EDAcompare – Base)  2 
EDAconduit (EDAconduit Base license) +1 

237  (InterComm Expert) +3 
Total = InterComm (InterComm Base License) =  6 

If this license file is for a node-locked license, a # symbol must be 
added to the beginning of these two lines. 

 NOTICE="PTC, 9876543" 
#################### FLOATING Option ##################### 
# Serviceable = InterComm EDAcompare - Full Version 
# Feature Name = 226 
# Feature Version = 2.1 



# Number of Copies = 2 
# Expiration Date = perm 
# Module = InterComm EDAcompare - Component 
INCREMENT 226 ptc_d 2.1 perm 2 90B08010E3D59B00D768 \ 
 VENDOR_STRING="VSVER=2.0 LO=()" SUPERSEDE \ 
 ISSUER=PTC-WEB-INSTALL ISSUED=14-dec-2005 \ 
 NOTICE="PTC, 9876543" 
#################### FLOATING Option ##################### 
# Serviceable = InterComm EDAcompare - Full Version 
# Feature Name = 227 
# Feature Version = 2.1 
# Number of Copies = 2 
# Expiration Date = perm 
# Module = InterComm EDAcompare - Net Basic 
INCREMENT 227 ptc_d 2.1 perm 2 5030103014FBF4D57B61 \ 
 VENDOR_STRING="VSVER=2.0 LO=()" SUPERSEDE \ 
 ISSUER=PTC-WEB-INSTALL ISSUED=14-dec-2005 \ 
 NOTICE="PTC, 9876543" 
#################### FLOATING Option ##################### 
# Serviceable = InterComm EDAcompare - Full Version 
# Feature Name = 228 
# Feature Version = 2.1 
# Number of Copies = 2 
# Expiration Date = perm 
# Module = InterComm EDAcompare - Net Advanced 
INCREMENT 228 ptc_d 2.1 perm 2 40F060D0CD7D5DCEDF86 \ 
 VENDOR_STRING="VSVER=2.0 LO=()" SUPERSEDE \ 
 ISSUER=PTC-WEB-INSTALL ISSUED=14-dec-2005 \ 
 NOTICE="PTC, 9876543" 
#################### FLOATING Option ##################### 
# Serviceable = InterComm EDAcompare - Full Version 
# Feature Name = 229 
# Feature Version = 2.1 
# Number of Copies = 2 
# Expiration Date = perm 
# Module = InterComm EDAcompare - Pin 
INCREMENT 229 ptc_d 2.1 perm 2 40F04070C65B169BEB0F \ 
 VENDOR_STRING="VSVER=2.0 LO=()" SUPERSEDE \ 
 ISSUER=PTC-WEB-INSTALL ISSUED=14-dec-2005 \ 
 NOTICE="PTC, 9876543" 
#################### FLOATING Option ##################### 
# Serviceable = InterComm EDAcompare - Full Version 
# Feature Name = 230 
# Feature Version = 2.1 
# Number of Copies = 2 
# Expiration Date = perm 
# Module = InterComm EDAcompare - Geometry 
INCREMENT 230 ptc_d 2.1 perm 2 E0409030BC56DB358712 \ 
 VENDOR_STRING="VSVER=2.0 LO=()" SUPERSEDE \ 
 ISSUER=PTC-WEB-INSTALL ISSUED=14-dec-2005 \ 
 NOTICE="PTC, 9876543" 
#################### FLOATING Option ##################### 
# Serviceable = InterComm Expert - 1 Country Floating 
# Feature Name = 237 
# Feature Version = 5.1 
# Number of Copies = 3 
# Expiration Date = perm 
# Module = InterComm Expert 
INCREMENT 237 ptc_d 5.1 perm 3 8030E0E06E506B7508D3 \ 
 VENDOR_STRING="VSVER=2.0 LO=()" SUPERSEDE \ 
 ISSUER=PTC-WEB-INSTALL ISSUED=14-dec-2005 \ 
 NOTICE="PTC, 9876543" 
#################### FLOATING Option ##################### 
# Serviceable = ICM CFG 1 
# Serviceable = InterComm Expert - 1 Country Floating 
# Feature Name = 240 
# Feature Version = 5.1 
# Number of Copies = 1 
# Expiration Date = perm 
# Module = InterComm CFG 1 
INCREMENT 240 ptc_d 5.1 perm 1 207060009046AD73EA2B \ 
 VENDOR_STRING="VSVER=2.0 LO=()" SUPERSEDE \ 
 ISSUER=PTC-WEB-INSTALL ISSUED=14-dec-2005 \ 
 NOTICE="PTC, 9876543" 
#################### FLOATING Option ##################### 
# Serviceable = ICM CFG 4 
# Serviceable = InterComm Expert - 1 Country Floating 
# Feature Name = 243 
# Feature Version = 5.1 



# Number of Copies = 2 
# Expiration Date = perm 
# Module = InterComm CFG 4 
INCREMENT 243 ptc_d 5.1 perm 2 A0A0E08039431360EC39 \ 
 VENDOR_STRING="VSVER=2.0 LO=()" SUPERSEDE \ 
 ISSUER=PTC-WEB-INSTALL ISSUED=14-dec-2005 \ 
 NOTICE="PTC, 9876543" 
#################### FLOATING Option ##################### 
# Serviceable = EDA Conduit for All 
# Feature Name = 249 
# Feature Version = 2.0 
# Number of Copies = 1 
# Expiration Date = perm 
# Module = InterComm EDAconduit 
INCREMENT 249 ptc_d 2.0 perm 1 20F05070F2732ABF9B73 \ 
 VENDOR_STRING="VSVER=2.0 LO=()" SUPERSEDE \ 
 ISSUER=PTC-WEB-INSTALL ISSUED=14-dec-2005 \ 
 NOTICE="PTC, 9876543" 
#################### FLOATING License #################### 
# Serviceable = InterComm EDAcompare - Base 
# Feature Name = EDACOMPARE 
# Feature Version = 2.1 
# Number of Copies = 2 
# Expiration Date = perm 
INCREMENT EDACOMPARE ptc_d 2.1 perm 2 \ 
 2010C070743860CE541E VENDOR_STRING="VSVER=2.0 LO=()" \ 
 SUPERSEDE vendor_info="VIVER=1.0 EXTERNAL_NAME=" \ 
 ISSUER=PTC-WEB-INSTALL ISSUED=14-dec-2005 \ 
 NOTICE="PTC, 9876543" SN=1A111111 
#################### FLOATING License #################### 
# Serviceable = InterComm EDAconduit for All 
# Feature Name = EDACONDUIT 
# Feature Version = 2.0 
# Number of Copies = 1 
# Expiration Date = perm 
INCREMENT EDACOMPARE ptc_d 2.0 perm 1 \ 
 2010C070743860CE541E VENDOR_STRING="VSVER=2.0 LO=()" \ 
 SUPERSEDE vendor_info="VIVER=1.0 EXTERNAL_NAME=" \ 
 ISSUER=PTC-WEB-INSTALL ISSUED=14-dec-2005 \ 
 NOTICE="PTC, 9876543" SN=1A111111 
#################### FLOATING License #################### 
# Serviceable = InterComm Base License 
# Feature Name = InterComm 
# Feature Version = 5.1 
# Number of Copies = 6 
# Expiration Date = perm 
INCREMENT InterComm ptc_d 5.1 perm 6 \ 
 70D0B02083F9EDF6B78B VENDOR_STRING="VSVER=2.0 LO=()" \ 
 SUPERSEDE vendor_info="VIVER=1.0 EXTERNAL_NAME=" \ 
 ISSUER=PTC-WEB-INSTALL ISSUED=14-dec-2005 \ 
 NOTICE="PTC, 9876543" SN=1A111111 
#-------------------------------------------------------------------------- 
#END: License File for HOST ID AA-BB-CC-DD-EE-FF 
#-------------------------------------------------------------------------- 
 
#-------------------------------------------------------------------------- 
#END OF THE LICENSE PACK FOR REQUEST ID 12345678 
#-------------------------------------------------------------------------- 
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